Lesson Plan

Microsoft Word: Resumes

A student learns how to create, format, and save a resume in Microsoft Word.
Learning Objectives
At the end of class, the student will:
● Be able to create a resume in Microsoft Word 2016 using simple formatting.
● Know how to use consistent formatting to highlight skills and experience.
● Be able to save a resume as .docx and .pdf and understand the difference between the two.
● Be able to distinguish between different types of resumes.
Lesson Prep Work
(30 min, at a minimum, prior to student arrival)
●
●
●
●

Get in early to test for technology failure, because it will happen :-)
pre-save example documents in S: drive, etc.
Put example resumes folder on desktop of each classroom computer.
Print handouts.

Lesson Prerequisites
● Computer Basics class or proven computer, mouse, keyboard, and internet browsing skills.
● Microsoft Word Basics class.
Lesson Outline
This lesson is completed in one (120) minute class session.
(5) Introduction
● Introduce instructor.
● Let students know it is okay to take phone calls, but ask them to put their phone on vibrate and
answer calls outside the classroom.
● Inform students that they can sit back and watch if the class is too advanced.
● Inform students they can go to the bathroom, they don’t need permission.
● Show order in which class will happen. Explain scope of class.
● WARM UP ACTIVITY: Ask students if they have a digital copy of their resume. Inquire as to
what type of job they’re looking for (if they’re willing to share). Ask them why they came to this
class.
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(30) The Resume
● Resumes
○ Discussion: Ask students what information goes on a resume?
■ Contact information
■ Experience
■ Education
■ Skills
■ Objective
● Teacher’s Tip: Objectives are not as popular as they used to be.
Encourage students to use a Summary of skills/qualifications instead.
○ Activity Open up the bad resume example
■ Discussion: Ask students why this resume isn’t very good.
● Inconsistent fonts
● Inconsistent language
○ Spelling
○ Grammar
● Confusing formatting
● Incorrect or misapplied use of bullets
● Resume isn’t chronological
● No contact information
● Types of Resumes
○ Chronological Resume
■ Explanation
● We’re going to look at a few examples of well written and organized
resumes. The first is a chronological resume, the other is a functional
resume.
● Chronological resumes
■ Activity: Open up “Chronological Day care.docx”
● Discussion: Ask students to explain what’s good about “Chronological Day
care.docx”.
● Teacher’s Tip: I like this resume because you know what type of job the
applicant is applying for. You may consider asking the students what type
of job the applicant wants.
○ Consistent fonts
○ Consistent language
○ Simple and logical formatting
○ Correct use of bullets
○ Dates in correct order
○ Contact Information!
○ Functional Resume
■ Explanation
● A functional resume focuses on your skills and experience, rather than on
your chronological work history. It is typically used by job seekers who are
changing careers, who have gaps in their employment history, or whose
work history is not directly related to the job.
DEER PARK PUBLIC LIBRARY
3009 Center St. | Deer Park, TX 77536 | 281-478-7208 | http://www.deerparktx.gov/library
Adapted, with permission, from Denver Public Library’s Computer Class curriculum.

1.13.2018

2

● Skills are highlighted instead of work history.
■ Activity: Open up “Functional Electronic Assembly.docx”
● Discussion: Ask students for feedback about the resume.
■ Teacher’s Tip: Students might ask if they can leave off dates of employment or if
they can “adjust” dates instead of leaving gaps in employment. It’s better to be
honest.
○ Google searching a resume example for a specific job
■ Explanation
● The easiest way to view other resumes in the same field you are applying
for is a simple Google search.
■ Activity: Perform a Google image search for “pipefitter resume example.” Have
the class follow along and show examples. You could also ask a student what
sort of position they’re looking for and use that as an example search.
■ Teacher’s Tip: Advise students to use this as a reference tool when writing their
own resumes. Remind them not every resume posted online is good, but some
resumes may have good ideas.
(40) Formatting a Resume
● Explanation
○ The easiest way to create a resume is to begin with a pattern (or template) that’s
already been created. We’re going to be using some tools in Word to format an
unformatted resume.
○ We’re going to:
■ Align text
■ Use the show format option
■ Change text
■ Use the format painter
■ Use and adjust bullets
■ Create tables
■ Add lines to your resume
○ Teacher’s Tip: Recommend students who haven’t used Word before take the Word
Basics class.
○ Teacher’s Tip: Do not use the templates included with Word. They are notoriously
difficult to manipulate.
● Activity: Open Unformatted resume.docx
● Activity: Center align “Danielle Foster”
○ Discussion: Why did only “Danielle Foster” become centered? Why didn’t we have to
select text to center it?
■ Word centers text based on what it defines as a paragraph. A paragraph in Word
is anything between hard returns or carriage returns (that’s when a user presses
enter).
○ Activity: Students toggle show formatting on (this is the ¶ symbol in the Home Tab)
○ Activity: Students select the remainder of the contact information by clicking and
dragging and then aligning it in the center.
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■ Teacher’s Tip: You can center multiple paragraphs by select them all.
● Activity: Using the format painter.
○ Explanation
■ One of the most important features of any resume is consistency. To maintain
consistency it is easier to copy formatting than it is to manually change every
heading on the page. That leaves a lot more room for errors. We’re going to use
the format painter to copy formatting.
○ Activity: Change the “DAYCARE QUALIFICATIONS & COMPETENCIES HEADING” to
bold, Helvetica, 14 pt font.
○ Activity: Use the format painter!
■ Teacher’s Tip: Make sure to point out to students that when selecting the format
painter the mouse pointer changes! Also, make sure to indicate that they only
need to select one piece of the text they’re copying formatting from, even just a
letter will suffice.
○ Activity: Select the formatted text again. Double click the format painter to toggle it on.
Finish copying the formatting to the remaining unformatted headings.
■ Teacher’s tip: Remind students that to toggle off the format painter they can click
on the format painter icon or press escape on the keyboard.
● Activity: Using bullets
○ Explanation
■ you will want to use bullets to clearly signify and separate out different
accomplishments and tasks at various positions.
○ Activity: Add a bullet!
■ Step 1: Place the cursor before the word “teaching” under “DAYCARE
QUALIFICATIONS & COMPETENCIES”
■ Step 2: Select the “Bullet” icon in the paragraph section of the ribbon (careful not
to select the down arrow –the down arrow gives options and will give your bullets
a different appearance but won’t affect the functionality).
■ Step 3: Undo this, because we’re going to do it better (write the hotkey {CTRL+Z}
on the board and show the undo icon in the quick access toolbar).
■ Step 4: Highlight all of the text under the “DAYCARE QUALIFICATIONS &
COMPETENCIES” heading (from “Teaching” to the word “license”).
■ Step 5: Select the bullet icon.
■ Step 6: Marvel as Microsoft Word correctly bullets each sentence.
● Teacher's tip: bullets are added after each hard return (every time you
press enter).
○ Activity: Increasing and decreasing indent on bullets
■ Explanation
● Occasionally you may want to increase the indent of a bullet (move it over
to the right, potentially to create a sub-bullet). This is not common with
resumes but you should be familiar with how to do it.
■ Step 1: Place the cursor at the beginning of the line that starts with “Teaching…”
that we just bulleted.
■ Step 2: Click the “Increase indent” button. Notice that the bullet moves to the
right and changes form (you can manipulate the shape of this bullet by selecting
the down arrows next to the insert bullet button).
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○

○

○

○

● Teacher's tip: You can also press TAB to increase the indent.
■ Step 3: Move the indent back, by selecting the decrease indent button.
● Teacher’s tip: You can also press SHIFT+TAB to decrease the indent.
Activity: Shifting bullet location
■ Explanation
● You can shift the location of all bullets by slight increments rather than
increasing or decreasing the indent.
■ Step 1: Place the mouse pointer over any of the bullets.
■ Step 2: Hold the left mouse button down and pull the bullet slightly to the right
(take special note of the vertical dotted line that illustrates where the bullet will be
moved to).
● Teacher’s Tip: This may change the formatting of your document in its
entirety, so use with caution (use undo liberally).
Activity: Getting rid of bullets
■ Step 1: Place the cursor after the word “license” in the final bulleted line.
■ Step 2: Press enter. Notice that a bullet will automatically appear.
■ Step 3: Press enter again.
● Teacher’s Tip: You can also use backspace to delete bullets, it just
requires more button presses.
Activity: Creating a table
■ Explanation
● Occasionally you will want to create a table in a resume to display a list of
skills or education. Tables work better than columns, and much better than
trying to format lines using the spacebar and/or tab key. We’re going to
create one today to organize the dates, type, and location of our
employment.
■ Step 1: Insert a 3x1 table (since we have three pieces of information to organize,
“2008-present”, “Private Residence”, and “Vail, CO”).
■ Steps 2: Copy and paste the following into the corresponding cell in the table:
● 2008-Present (1st cell)
● Private Residence (2nd cell)
● Vail, CO (3rd cell)
■ Step 3: Hover the mouse pointer over the line between the 1st and 2nd cell and
click and drag the line to the left, so that “Private residence” is next to “2008Present.”
■ Step 4: Select the cell with “Vail, CO”, click the home tab, and right align the text.
● Teacher’s Tip: We can manipulate each cell independently, rather than
trying to use the spacebar or tab button to left align one part of the line,
and right align another part of the same line.
Activity: Remove borders around table
■ Explanation
● If you’d like to remove the borders (lines) from around the table (which you
most likely will for your resume) it’s fairly straight forward.
■ Step 1: Select all cells in the table by clicking and dragging (like highlighting text).
■ Step 2: Select the Design tab in the ribbon.
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● Teacher’s tip: You will only see the design and layout tab when you select
the table.
■ Step 3: Select the down arrow next to the borders option.
■ Step 4: Select no borders (you can always reverse this change or just have a
border in the middle or whatever is preferred).
● Teacher’s tip: If you need to find out where the tables in your resume are,
but you have removed all borders, select a cell within a table, click on
Layout, and click on View Gridlines. You can also move your pointer
around the page and look for the four sided arrow icon (this will indicate if
you are hovering over a table).
○ Activity: Copying a table
■ Explanation
● So that your tables remain consistent, copy and paste the table from one
section to the next.\
■ Step 1: Click the cross hair pointer to the left of the table
■ Step 2: Click CTRL + C to copy the table
■ Step 3: Position the curser where you want to paste the table
■ Step 4: Click CTRL + V to paste the table
■ Step 5: Enter the new information in the table.
○
○ Activity: Adding lines to your resume
■ Explanation
● Occasionally you may want to add a line between sections or to
distinguish some part of your resume.
■ Step 1: Place the cursor after “COMPETENCIES” in the first heading and press
enter.
■ Step 2: Type in “===” and press enter.
■ Step 3: Watch a double line magically appear underneath the 1st heading.
■ Step 4: Place the cursor after “EXPERIENCE” in the second heading and press
enter to add a line.
■ Step 5: Type in “---“ and press enter.
■ Step 6: Watch as a single line magically appears under the second heading.
● You can also use ***, ___, ===, ###, and ~~~ for different types of lines.
● Teacher’s Tip: You can also draw lines using auto shapes, but these can
be particularly inconvenient to fit exactly with your margins.
(10) Save vs Save As
● Activity: Students use the Save As function to save the file.
○ Explanation
■ Save As makes a new version of a document while leaving the original intact. If
it’s your first time saving a document you have to tell the computer three things:
● Where do you want to save the file?
● What do you want to call the file?
● What type of file do you want it to be?
■ After saving a document for the first time when you click “save” you are
overwriting the original.
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■ After saving a document for the first time when you click “save as” you are
creating a new version of the document and leaving the original intact. Anytime
you click “save as” you will
○ Step 1: Select “save as”.
○ Step 2: Select the location to save as the desktop.
○ Step 3: Name the file. Illustrate importance of naming resume appropriately. Titling a
resume with the name of the position you’re applying for and your name may be a good
idea. Employers will be able to see the file name.
○ Step 6: Click Save in the dialog box.
● Comprehension check
○ If I want to make two different versions of my resume, one for customer service and one
for management, should I use save or save as?
○ If I update a template I use for a cover letter, should I use save or save as?
○ Teacher’s Tip: If some students are having trouble with this concept, encourage them to
attend the Saving and Finding Files class.
● Activity: Saving as a .pdf
○ Explanation
■ When you save a document as a .doc (or .docx) you can make changes to the
document. When you send your resume to a potential employer you may want a
file format that can’t be edited and that will retain the intended formatting.
○ Demo: Delete something on the resume template to demonstrate how easy it can be for
someone to accidentally alter your document.
○ Step 1: Click on the File tab.
○ Step 2: Click on Save As.
○ Step 3: Click on the down arrow in save as type field.
○ Step 4: Select PDF from the drop down menu (you may need to scroll down).
○ Step 5: Click Save.
■ Teacher’s Tip: Because the class is saving their resumes as a .pdf they do not
need to re-title it, it will not overwrite their original resume because the file is a
different format.
■ Teacher’s Tip: Remind the students that certain businesses will request their
resume in a particular format.
○ Make sure you ALWAYS have a .docx version of your resume so that you can edit it.

(5) Conclusion
● Go over handout, review material, and emphasize contact info & further resources on handout.
● Any questions? Final comments?
● Remind to take survey.
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Appendix
What This Lesson Does Not Cover
● We don’t cover what you should write in the resume directly. Encourage students to use the
Texas Workforce center for additional help with what to write on their resume
Key Decisions
● Attendance for this class is on the low side, but we feel it is valuable enough to keep around
(for now).
Links
● How to use the format painter: https://support.office.com/en-us/article/Use-the-Format-Painter4bb415a9-d4e4-42b7-b579-170adc594e40
● Working with tables in Word: https://www.gcflearnfree.org/word2010/working-with-tables/1/
Lesson Plan used and modified from Denver Public Library with permission.
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